
DBS Chess

This program is intended to be an ethical assistant in recording your moves and analysis 
of chess games.    Ethical in the sense that it does not help or advise you as to which is the "best" 
move.    The idea is to let you remember your analysis as well as the actual game moves.

I wrote this program with the principal aim of its being applicable to correspondence 
chess.    No doubt it will also be useful for post-mortems of OTB games.

What it will do is to list the available legal moves in any position, allow you to explore 
(and record) variations other than the "game" line and add comments.

Note that the disclaimer includes no liability on my part if your analysis is insufficient to 
snatch victory from the jaws of defeat (or vice-versa). 

Use the Search facilities of help to get help of specific topics OR press the F1 key during 
the run of the program (when some areas may get you directly to the relevant topic).    Some of 
the more important topics are (just click on the coloured items) :-

Game Moves, Variations, Moving, Printing, Saving, , 
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Game Moves.

By default the first move made from a given position is classified as the "Game" move.    
At any time you can mark the moves that got you to the current position as having that status 
(demoting the previous Game moves to Variation status).    To do this either

a) Use the option in the Edit | Mark as Game to here menu.

or b) Press the  symbol on the "toolbar" line.

Thereafter you will find that if you backtrack to an earlier position, the game move is 
shown at the top of the list of available moves, and preceded by an asterisk (*) symbol.

The process can be reversed, i.e. the move sequence converted to merely Variation status 
by either

a) Use the Edit | Game to Variation menu.

or b) Press the     button.

Note that the move that resulted in the current position and all subsequent variations 
thereof are now of Variation status.

Only one line can be marked as the Game, but "Game to Variation" can result in only 
variations existing beyond a certain point.



Variations.

If you analyse a sequence of moves, they are automatically marked as a known variation. 
When you backtrack to an older position, you will find that a variation move is preceded by a ? 
in the list of valid moves.

      Allows you convert a variation to game status. The alternative is to use the Edit | 
Mark as Game to here menu.

       Allows you to remove a variation; you position yourself at the point in the game 
which is the start of the unwanted one (which may diverge later into subvariations, all of which 
will also be removed). The alternative is to use the Edit | Kill variation menu.

    Takes you to the alternative display (Alphabetic / Analysis) in which the variations 
are listed



Legal Moves

Alongside each current position is a list of all the legal moves that can be made.

If a sequence of moves has already been marked as the Game, the current game move is 
at the top of the list, marked with an asterisk.    Next come any variations previously noted - 
these are marked with a question mark.    Thereafter, the other moves are listed in alphabetical 
order.

If there are a lot of moves, it is necessary to scroll down the list by clicking in the right-
hand margin of the field to see the later ones.

An alternative method if you wish to see only the moves available to a given object is to 
click that object on the board display.

If you click on one of the moves in the move list, that move is made.

A move which causes check is marked with a plus sign in the normal way.    Note that no 
special attention is drawn to a move that causes checkmate or stalemate - it is only when the 
move is played that you are informed.

If you cannot make the move you intended, please think about whether it really is a 
possibility.    NB the rules for castling, en passant and not moving into check! 

What the program does not implement is :-

a) Draw by repetition of the position 3 times over.
b) Draw by 50 moves without a pawn move or piece exchange.



Castling

King side castling is referred to as O-O, Queen side by O-O-O.

You can make the move either by clicking from the move list, or by dragging the King 
from the e column to either g or c as appropriate.

Note that you cannot castle if any of the following apply :-

a) The King or the Rook concerned have already moved.
b) The King is in check, would end up in check, or moves over a square (f or 

d column) that is attacked by the enemy.



En Passant

Many years ago, when the world was still young, it was decided to speed up the game by 
allowing a pawn to move forward 2 ranks on its first move. 

However, it was pointed out that this denied the opposition the chance to exchange pawns 
as it passed the intermediate rank.    E.g. if White has a pawn on d5, then Black can play c7-c5 
without allowing the d pawn the chance to capture on c6.    The En Passant rule says that in this 
situation White can play dc (with his pawn ending up on c6) just as if the Black pawn had only 
made a single rank advance. 

However, it was then pointed out that if White does not avail himself of the opportunity, 
Black would to be able to get his pawn to c5 and leave it there no longer under threat, as if it 
had travelled there under the old regime of c6 and then c5 next move. 

Therefore, to keep everyone happy, the rule is that you get the chance of e.p. only if you 
opt for it immediately after the special double advance was played.



Dates

In correspondence chess you record the dates when a move was received and when you 
get it back into the post.

Originally I had intended to calculate the total time elapsed for the Game moves.    
However, the rules as to whether Sundays, Holidays and agreed Cessations make this far too 
complicated and variable.

I've just left the Received and Sent fields as simple text areas for your convenience to fill 
in in the notation of your choice.



Bitmaps

The Board probably isn't to your taste as regards the choice of colours, shape of the 
horses, etc.!    (I thought not). 

There are some alternatives given in the subdirectories each having a name of the form 
xxxx.BMP, where xxxx is a colour.    If you examine these you will find that they each contain 
26 BMP bitmap files - you can use the Edit | Load Bitmaps menu entry to load one of these sets 
instead of the default set. 

The issued choices have been chosen to be compatible with 16 colour displays, with the 
exception of BRWN.BMP.    I am using BRWN as the default and sometimes find that it only 
works properly after reloading it using the bitmaps - comments appreciated if you find this 
problem.    The black & white version (BW.BMP) is probably most suitable for printouts using 
the clipboard, the board will be improved by the addition of a border from your word processor.

If you wish to make your preferred choice the one it starts up with, simply copy the 
26 .BMP files from a subdirectory onto the files in the working directory (e.g. \DBSCHESS).

If you are very brave, then there is nothing to stop you designing your own set as long as 
you stick to the following rules :-

a) All the files are 48 * 48 pixels BMP files.
b) The blank square representations are Light.bmp and Dark.bmp.
c) Other files are of the form XYZ.bmp where :-

i) X is colour of the piece (W=White, B=Black)
ii) Y is the piece name (K, Q, B, N, R & P).
iii) Z is the background colour (L=Light, D=Dark).

d) Set up the 26 files in a directory having a name of the type xxxx.BMP so that they 
can be found by the Edit | Load Bitmaps files menu command.    Yes I do mean a in directory 
whose name has its last 4 characters as ".BMP".

I suggest that you use your favourite painting package (or Paintbrush in a real 
emergency) starting from one of the supplied    examples.    I can't be responsible if you do 
anything that doesn't fit in with the above rules - in particular if it causes an error.



Making a move

There are several ways of moving :-

a) Click on one of the moves displayed in the list of valid moves.    Algebraic 
notation (long variety) is used.    You may first have to cancel the box showing the most recent 
moves if you have used the  button.

b) Click on the piece you intend to move.    The list of valid moves then changes to 
the subset of moves that apply to the chosen piece.

c) Click and hold down the mouse so that you drag it from the original square of 
your chosen piece to the destination you intend.    Note that to castle drag the King only, to make 
an En Passant move drag from the present square to the one on which the pawn ends up.

There is one situation in which method (c) does not work - pawn promotions.    As I have 
to find out which piece you wish to promote to, please select from the list of valid moves.

You may wish to add some comments to the move.

A translation of the move to reach the current position is also given in the International 
notation if the item View | International (as well) is checked.    To change its status click on that 
menu entry.

The View menu controls which side you view the board from and whether this changes 
between moves.

The View settings are saved together with the game on File | Save and File | Save As.



End of Game

You can jump to the final position, i.e. the one at the end of the sequence of moves 
marked as game ones, either by

a) Use the Move | End of game menu.

or b) Press the     symbol on the "toolbar" line.

If there are no valid moves from this position it is either checkmate or stalemate!



Checkmate

Checkmate is defined as the situation where the player is in check and has no legal 
moves.    That player has lost!



Stalemate

Stalemate is defined as the situation where the player is NOT in check and has NO legal 
moves.    That player has got himself/herself a draw (and a large smile on their face!).



Back 1 move

To backtrack by just one move, you can either    :-

a) Use the Move | Back 1 move menu.

or b) Press the  symbol on the "toolbar" line.



Backtrack

Allows you to go to any earlier position with respect to the current one.    You are given a 
listing of all the moves in the game so far to get to the current position.    This window is 
displayed if you either :-

a) Use the Move | Backtrack menu.

or b) Press the  symbol on the "toolbar" line.

Note that you arrive at the position before which the selected move was played.



Calendar

The calendar comes to you (basically) courtesy of the Delphi system in which this 
program is written.    At least it's one way to find out what is today's date, but if you want to find 
out which day of the week you were born on ...

You can move up or down a month relative to the current display by clicking on the spin 
button on the top row.    Alternatively you can choose a specific month using the tabs at the 
bottom - or the year by clicking / sliding the scroll region just above the tabs.



New game

This is the first option in the File menu.

It saves you all that fiddly business of putting the bits of wood back onto their starting 
squares!

If the current game has been amended and not saved to disc, you are given a chance to 
save it first.    You are asked to provide the various details to identify the game - none of the 
fields are compulsory



Comments

There are two sorts of comments :-

a) Describing the game itself (given when you start a new game).

b) Describing a given move - i.e. appearing with the position after the move has been 
played.    They appear (and can be edited) in the box at the bottom right of the normal screen.

The menu item Edit | Comments contains two sub entries to allow you access to the two 
sorts of comments.    Note that the dates associated with a move are only relevant during the 
printout of a game.

Dates in comments are simply free text.



Printing

I had originally intended to build printing facilities (including font selection etc.) into the 
program.    However there are so many options that it would have meant writing a word-
processor from scratch.    Instead I have decided that the most practical way is to use the 
Clipboard so that you can interface with your favourite worm-processor. (sic).

There are 2 places where you can create new clipboard contents :-

a) In the Edit | Copy to Clipboard menu to produce :- 

1) A simple set of the game moves.
        or 2) A bitmap of the board

In option (1), you must select between having the moves produced in the mode :-

i) Newlines.    A tab character is inserted between the move number/ white 
move and white move/black move values. The next move pair is then 
on the next line.

ii) Semicolon.    A space is used instead of a tab, and the move pairs are 
separated by a newline only when there is a danger of exceeding the 
255 string length limit!

iii) Correspondence.    Just the players' names and the 3 latest moves are 
given.    This is to aid the composition of your e/snail mail reply to the 
opponent.

b) Within the more complicated screen from View | Analysis.

This output is produced in the style of "Newlines" above.    You should 
either select the entire output (use the button) or drag the cursor over the required 
area to define the area to be sent to the clipboard.

If you wish to use the clipboard more than once during the annotation of a game, you are 
advised to have both the word-processor and DBSCHESS running and use Alt/Tab features of 
Windows to switch between them, .



Errors

Errors are fatal.    I have written the program on the basis that I would rather know about 
them than attempt to make a soft recovery. 

Apart from the few that are obviously "your fault", please send me any details of GPFs 
that might give me any clues as what might have caused my list and memory handling to go 
astray.

NB "your fault" errors include those resulting from any changes to the .DBS files not 
made by this program!



Saving

The File menu items Save and Save As allow you to place a disc record of the game and 
all its variations onto a disc file of your choice.

This mechanism is also triggered if you start a new game or exit using the File | Exit 
menu item.

The properties of Language, International moves and Viewpoint are saved with the file. 



Clipboard

Either the game moves or the current board may be copied to the clipboard, e.g. for use 
for insertion into a word processor document.    Choose an option from the window after the 
Edit | Copy to Clipboard menu.

The game moves are listed, without comments or variations, in the following styles :-
EITHER      (Newlines)

1. e2-e4 Ng8-f6
2. e4-e5 Nf6-d5
etc.

(where there are tab characters between the move number and the moves).

OR             (Semicolons)
1.e2-e4, Ng8-f6;    2.    e4-e5, Nf6-d5;    etc.

OR             (Correspondence)
 23.  d5-d6  c7xd6

24. Nf3-e5 Qd8-e8
25. Qd1-f3 Ra8-b8

depending on the option chosen after Edit | Copy to Clipboard. 

 In the second option, the output does not consist just of one enormous string, but is 
broken up every couple of hundred characters into separate records. 

The third option just gives the latest 3 move pairs and is designed for composing the 
reply to your opponent - so you must be positioned at the last game move.    I've done this 
deliberately to force myself to make sure that the game is in the correct state when I've decided 
on the move.

The moves are preceeded by the game details - except in the third option when only the 
players' names are given.

The current board is copied as a bitmap.

Analysis from the View | Analysis    (or    ) is given with tab characters separating the 
columns.    From this window you can either click the button to select everything or drag the 
mouse over the required area for a subset.

Note that the language notation used is that currently selected from the View | Languages 
menu.



International

The International notation for correspondence chess moves is an ultimately simple 
system, whereby a four digit number alone is used.    The first 2 digits specify the start position 
of the object being moved (with the algebraic column value a-h being replaced by digits 1-8 
respectively).    The last 2 digits similarly give the co-ordinates of the square being moved to.    
The conventions for Castling and En Passant are the same as are employed in this program, i.e. 
use the start/end positions of the K/p concerned.    Pawn promotion does not seem to be 
addressed!

The International notation is displayed on the standard screen as well as the algebraic 
version of the last move played if the View | International menu entry is selected by clicking on 
it (and again to remove it).

In printouts it is similarly displayed if the option to include it is ticked in the "included" 
section of the screen that appears when you select the View | Analysis menu.

Languages

Apologies, but my linguistic abilities do not extend to providing help except in English 
(similarly the words displayed when the program runs).    However, I can at least allow you to 
display the moves with the abbreviations for the pieces in Spanish, French or German - use the 
View | Languages menu to select an option and you may feel more at home thereafter.    Note 
that setting a non-English option affects the output to the clipboard and the expected notation in 
the import of games.



Variation Listing

You arrive at a text grid either by the use of  or View | Analysis.

The problem with showing an arbitrarily complicated branching of possible moves is the 
way to list them.    My solution is first to sort the variations so that the "heaviest" one comes last 
- in the style of "this move is the way forward, if there is a short digression let's get it out of the 
way first before continuing".

From a given position the variation moves are called ?1, ?2, ?3 etc (surprise!, but after 9 I 
go to ?a, ?b etc - you must be a real enthusiast to need these).    The first subvariation of ?1 is ?
11, the second subvariation is ?12.    Thus ?3122 is the second subsubsubvariation of the second 
subsubvariation of the first subvariation of the third variation of the current position!

Starting form a well known (i.e. initial) position, we could have :-

?1 e2-e4
?11 e7-e5
?12 c7-c5

?2 d2-d4
?21 Ng8-f6

?211 c2-c4
?22 d7-d5

?221 c2-c4
?2211 d5xc4

?3 Ng1-f3
?31 Ng8-f6

?311 d2-d4
?3111 g7

?312 g3
?3121 g7
?3122 d5

?31221 Bg2

The analysis display uses indentations - until it gets too far to be readable.

If you decide to add a lot of moves to one variation line, note that it gets re-sorted to 
appear last - hence the numbering of the line may change.

To return from the analysis page to the normal graphical display, double click anywhere 
in the row describing the required move.

The default options for the display give variations and comments, and not dates and 
international notation.    If you change these, it will also affect the output sent to the Clipboard.



Editing

The normal rules apply when you are editing within a text area (e.g. the Tournament box 
in the New Game window).    I.e. if an area is highlighted by dragging the mouse across it :-

a) Alt | c copies the text to the clipboard.

b) Alt | x cuts the text to the clipboard.

Thereafter you can paste the result with Alt | v.

The Home, End and Delete keys have the obvious effect within a text area.



Matériel Difference

The  symbol on the toolbar produces a display of the difference in strength of the 
opposing armies.



Latest Moves

Click on  to see up to 8 of the most recent moves to get to the current position.    This 
display overlays the list of currently available moves and you will have to remove it (use the 
Cancel button) in order to be able to scroll the complete list of available moves.



Import

I endeavour to create a series of game moves from the contents of the clipboard - which I 
trust are in the full algebraic notation of the language currently selected.

I ignore bits of punctuation like , ; + ! and tab characters. 

I expect to find move numbers before the white moves, and will ignore text up to the first 
1. of the game.

I will accept * as an alternative to x for capturing a piece, and ep or e.p. for en-passant.

Pawn promotions moves must have the =Q (or whatever) appended.

This is obviously a "hairy" area, so please be forgiving if it isn't 100% sucessful.    I am 
happy to receive comments on problems with importing from any variants of long algebraic 
listings - but not short algebraic or descriptive!!    Registered users could suggest I work on the 
latter - I will see if I get enough requests to go down that road!



Autoplay

The Move | Auto Play menu selection plays through the game from the start 
automatically.    You can control the time interval between moves to be in the range 0.2 to 9.8 
seconds by clicking on the up / down arrows.    At any point you may pause the game and 
subsequently resume by pressing the upper control button again.    The cancel button leaves the 
game in the normal mode at the point displayed.




